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1.1 Introduction 

SureSync is a powerful file replication & synchronization utility which can be used to ensure users 
on your network are always working off the most recent version of critical files, for disaster 
recovery purposes, for software distribution, and much more. 
 
This evaluator’s guide is designed to walk you through the initial setup of the SureSync product. 
By reviewing this guide you will become more familiar with the options within SureSync and how 
to get them configured quickly and easily so you can begin to take advantage of this powerful 
software package. 
 

1.2 System Requirements 

SureSync will run on the following operating systems: 
 
 Windows 2008 
 Windows Vista 
 Windows 2003 
 Windows 2000 
 Windows XP 

 
SureSync can synchronize data to operating systems such as Windows 95, Windows 98, 
Windows NT 4.0, and non-Windows machines such as Macintosh and Linux machines via UNC 
path but the software itself must be installed on one of the supported operating systems listed 
above. 
 
SureSync takes advantage of current Microsoft technologies. The system(s) running the full 
SureSync installation must also have the following: 
 
 Microsoft .NET 2.0 Framework 
 Microsoft Data Access Components (MDAC) 2.8 
 Microsoft Jet 4.0 SP8 

 
The SureSync installer will check for the appropriate versions of the .NET Framework, MDAC, 
and Jet. If your system needs to be updated the installer will give you the option to install these 
components. 

1.3 Contact Information 

If you need further information about SureSync or need clarification on anything within this guide 
please contact our support group and they will be happy to assist you with your evaluation. 
 
Software Pursuits, Inc. 
1500 Fashion Island Blvd., Suite 205 
San Mateo, CA 94404 
 
Phone: +1-650-372-0900 
Fax: +1-650-372-2912 
 
Sales e-mail: sales@softwarepursuits.com 
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Support e-mail: support@softwarepursuits.com 
 
Technical support is available between 8:00AM and 5:00PM PST Monday through Friday. 

1.4 Add-On Products 

Software Pursuits offers add-on products that enhance the functionality of the SureSync software. 
The following add-on products contain features you might want to take advantage of in your 
environment. 

SPIAgent Add-on 

 
The SPIAgent is a TCP/IP based agent which adds a number of additional features to the 
SureSync product. The SPIAgent provides the following: 
 
 Real-Time Monitoring 
 Adaptive Delta Copies 
 Compression 
 Encryption 
 QoS 
 Multicasting 

Advanced Open File Support (AOFS) Add-on 

 
The AOFS add-on allows SureSync to synchronize files which are held open locked or open 
exclusively such as Outlook .PST files.  

SPIAgent File Locking Add-on 

 
The SPIAgent File Locking Add-on feature will lock files when they are open in one location 
presenting users in other offices with an error message indicating that the file is in use. This 
eliminates the possibility of a user changing a file on multiple sides of a synchronization. 

ArchiveSync Add-on 

 
The ArchiveSync add-on license provides disk-to-disk backup and file versioning. The versioned 
archive of files stored to hard drive media allows for rapid recovery and point-in-time restores. 
ArchiveSync archives can be run in real-time which helps eliminate the traditional tape backup 
window associated with running backup jobs on a scheduled basis. 
 
Details on configuring ArchiveSync can be found in the SureSync Help File under SureSync Add-
ons | ArchiveSync. 
 

1.5 Installation 

The first step in configuring SureSync is to install the software in the appropriate locations. A 
basic SureSync installation involves one “main” SureSync machine. This is the machine where 
the full SureSync application is installed. It is also where you will configure your replication & 
synchronization jobs, run the SureSync scheduler, and monitor the progress of your 
synchronizations. 
 



Software Pursuits, Inc. 
www.SoftwarePursuits.com  

4

To install the full SureSync application you would run SureSyncSetup.exe on the machine and 
follow the installer prompts. Installers can be downloaded from http://www.softwarepursuits.com. 
 
If you are planning on using the SPIAgent you must also install the SPIAgent only installer on all 
additional machines involved in your jobs. To install the SPIAgent only on a machine you would 
run SPIAgentSetup.exe on the machine in question and follow the installer prompts. 
 
Note: The full SureSync installer includes the SPIAgent components for that machine. You should 
not run both the SureSync and SPIAgent installers on the same machine. 
 
If you are planning on using AOFS you must install the AOFS software on each machine which 
will be the source of a locked open file copy. This is done by running OpenInst.msi on the 
machine in question and following the on screen prompts. The SPIAgent is required when 
replicating locked open file copies residing on remote machines. 
 
Note: If you are using Windows 2003 Server, SureSync is able to utilize the VSS technology in 
Server 2003. Therefore you will not need to install the AOFS components. AOFS support for 
Windows 2003 is provided free of charge. 
 
If you are planning on using the SPIAgent File Locking Add-on then you will need to install both 
the SPIAgent and the SPIAgent File Filter Driver on each machine involved. File locking is only 
provided for Real-Time Monitors running synchronization jobs using a multi-directional rule. The 
SPIAgent File Filter Driver is installed by running SPIAgentFileFilterDriver.msi on each machine 
involved in the synchronization. 
 

1.6 Creating a Relation 

Relations are the basic building blocks of the SureSync application. Each Relation contains the 
root paths (source and destination paths) which apply to that Relation and options for the 
Relation. Each Relation also contains one or more Rules which tell SureSync how to replicate & 
synchronize data. The Relation and the Rule are created together in one wizard. 
 
Important: The wizards are designed to quickly and easily configure the basic options needed to 
get a Relation up and running. SureSync is an extremely flexible product with many advanced 
options. Additional options can be specified on the properties panels for the Relation after it has 
been created. 
 
To create your first relation, launch SureSync and then go to the "File" menu and select "New" 
and "Relation".  
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Name Your Relation 

 
 
The first panel in the wizard allows you to name your relation. Enter the name of the relation and 
an optional description and click “Next” to continue. We will refer to "Evaluation Relation" as the 
name of this relation for the example.  

Specifying Root Paths 

 
Important: There must be at least two root paths specified (a source and a destination) to have all 
rule types available. Later on in the wizard you will get to specify which path is source and which 
is destination. If you specify only one path then the only rule methods available later in the wizard 
will be “delete” and “skip”. 
 
For this relation we will assume the following: 
 
 The source path (where we’re synchronizing data from) is on the "c:" drive of the machine 

where the full SureSync package is installed and is a directory named "data". 
 The destination root path (where we’re synchronizing data to) is on a remote machine and 

is a share named "data". 
 We will be using the “Mirror Rule”, which will make the destination have the exact same 

files as the source. 
 
The next panel is used to specify the source and destination root paths that you want to 
synchronize. Later in the wizard you will specify which path is source and which is destination. In 
this dialog box you are simply listing the paths, both source and destination, which will be part of 
this synchronization. 
 
Root paths are added by clicking the “Add” button at the bottom of the panel to display the “Select 
a new root path” panel shown below. 
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As mentioned previously, our root paths are:  
 

 c:\data (This path will be specified as the Source Root Path in an upcoming panel) 
 A share named "data" on a remote machine (This share will be specified as the 

Destination Root Path in an upcoming panel)  
 
First we will select the source path by browsing to that path through "My Computer", highlighting 
the directory, and clicking "OK". Repeat the process for the destination path(s). You can browse 
through "My Network Places", enter in the UNC path manually, or use an already established 
drive mapping for the remote path.  
 
Note: If you are licensed to use the SPIAgent add-on and want to use that functionality you need 
to reference the agents in your root paths. This involves making a modification to the way you 
specify your root paths. You can get more detail on this process in the SPIAgent section of this 
guide. 
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Note: If you are using the ArchiveSync Add-on there are additional steps which need to take 
place in order to build an archive job. Details on configuring an archive job can be found in the 
SureSync help file under SureSync Add-ons | ArchiveSync. 

Determining the Best Rule 

 
SureSync offers a number of different replication & synchronization methods, allowing a great 
deal of flexibility in how your data is handled. A chart detailing each of these rules can be found in 
the help file under “Synchronization Methods”. 

Selecting Your Rule 

 
On this next panel we will specify the rule to use for this job. 
 
Note: If the panel indicates that only "Delete" and "Skip" rules are available, you have selected 
only one root path. You should use the "Back" button to return to the root path entry panel and 
add your other root path(s). 
 
The type of rule we will be using is "Mirror". Click on the rule you wish to use. 
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Note: A brief description of the rule you have selected is displayed just under the selection 
window.  
 
Click the "Next" button to continue.  

Selecting Source and Destination 

 
The next panel allows you to indicate which root path is to be used as a source and which is to be 
used as a destination. 
 
You indicate each by checking the boxes in the correct field. In our example the source path is 
"c:\data" and the destination is "(All Paths Except Source)". You can also check the destination 
paths instead of using the all paths except source option. 
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Filtering Subfolders 

 
The next panel in the wizard allows you to include or exclude specific subfolders. The default “\” 
means to include all subfolders. You can enter subfolders into the text field or select them using 
the checkboxes in the browse dialog on the lower portion of the wizard panel. Folders are 
excluded by placing a minus character (-) in front of the folder name. Multiple folder entries are 
separated by the vertical bar character (|). 
 

 
 
Examples 
 
To synchronize only two subfolders named FolderA and FolderB you would enter the following: 
 
\FolderA\ | \FolderB\ 
 
To synchronize all subdirectories except for subfolders FolderA and FolderB you would enter the 
following:  
 
\ | -\FolderA\ | -\FolderB\ 
 
To learn more about how to include and exclude subfolders press the F1 key on this panel.  

Filtering Based on File Masks 

 
The next panel displayed will let you indicate the files to be included or excluded from the job. 
Each entry in this panel should be separated by a vertical bar (|) character. To exclude a file 
name or file type place a minus sign (-) in front of the mask. 
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Examples 
 
To synchronize only *.doc files and a file named Test.txt you would enter the following: 
 
*.doc | Test.txt 
 
To exclude *.tmp files, *.doc files, and a file named Test.txt you would enter the following: 
 
-*.tmp | -*.doc | -Test.txt 
 
The default setting for this panel is *.* | -*.tmp | -~*.doc. This tells SureSync to synchronize all 
files except *.tmp files and temporary doc files. This is the setting we will use for this example. 
 
To learn more about how to include and exclude files based on file masks press the F1 key on 
this panel.  
 
Clicking the “Finish” button will create your Relation. The Relation Wizard only displays a subset 
of essential options for a Relation. There are many other options which can be configured by 
modifying the properties of the Relation using the SureSync Desktop. Pressing the F1 key on any 
tab in the application will display context sensitive help detailing the options on that tab. 

Previewing Your Relation 

 
Once the Relation has been created SureSync will prompt you to preview the newly created 
Relation. The preview displays the actions that SureSync would perform without actually doing 
them. This is a great way to determine if your relation is performing as expected. You should 
always preview a relation after making changes. 
 
When prompted to preview, click on the "Yes" button. 
 
There are different displays available for the preview by selecting options under the "View" menu. 
Please consult the SureSync Help File for more information about the preview window. 
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You may browse through the folders in this window and see how your files are affected. A legend 
can be accessed from the “Help” menu by selecting “Legend”. This will detail what the various 
preview icons mean. 
 
When you are done with the preview, close the preview window.  
 
Note: When setting up additional relations you can run the relation from the preview window. For 
this example simply close the window. When doing this no action is taken.  
 

1.7 Creating a Schedule 

A schedule is used to specify when one or more Relations should be run. Schedules are very 
flexible and can be configured to run a Relation at a specified time, or specified time intervals, or 
only on specific days of the month, days of the week, weeks of the month, or months of the year. 
This allows a very granular level of control over when synchronizations occur. 
 
In this example we will create a Schedule that will run the Evaluation Relation created in the 
Relation section of this guide, every evening at midnight.  
 
To start configuring your schedule, go to the File menu, select “New”, and then “Schedule”. 
 
Important: The wizards are designed to quickly and easily configure the basic options needed to 
get a Schedule up and running. SureSync is an extremely flexible product with many advanced 
options. Additional options can be specified on the properties panels for the Schedule after it has 
been created. 

Name Your Schedule 

 
The first panel allows you to name your schedule. Enter the name of the schedule and an 
optional description. Then click “Next” to continue. 
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Select What Relations to Run 

 
This next panel is where you specify which relations you would like the schedule to run. Specify 
these relations by checking the box next to their name. 
 

 

Setting Schedule Frequency 

 
The next panel provides options on how often you want the schedule to run. 
  
By default, the "Run this job only once" button is selected. However, for our example we want to 
run the schedule every day at midnight so we would select the "Schedule this job to run multiple 
times" button. 
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Once you have selected "Schedule this job to run multiple times." press the "Next" button to 
continue. 
  
The next panel allows us to set more options regarding the schedule frequency.  
 
For our example we want the schedule to run every day.  

 
 
 
The next panel allows you to set more options on how frequently you would like your schedule to 
run. If you want your schedule to be run more than once a day you would configure that here. 
  
For our example we leave this panel at default. If you would like more information on the settings 
on this panel press the F1 key.  
 

 
 
Click the "Next" button to continue.  
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Setting Schedule Start Date 

 
The next panel is where you specify the start date and time for the schedule. The default time for 
new schedule is 12:00AM. This can be configured in Options on the "Scheduler" tab if you would 
like it to be something different.  
 
You can pick a future date and time for the schedule to activate. You can enter in a date and time 
manually or you can pull down the menu to select the date from a calendar.  
 

 
 
Click the “Finish” button to create your Schedule. 

Modifying Your Schedule 

 
Your schedule is now complete. You can make changes to the options of your schedule in the 
main SureSync window by first clicking on the schedule you wish to modify. You can then look 
through the tabs on the right side for options to change. Pressing F1 while on any tab will bring up 
context sensitive help, describing the options in detail.  
 
Note: You must have a scheduler running for your schedule to run at the scheduled times. A 
scheduler can be installed by going to the Tools menu, selecting Schedulers, clicking on the 
Install button and then providing a username and password for the Scheduler to run under. 
 

1.8 Configuring the SPIAgent 

This section of the guide will show you how to configure your SureSync installation to take 
advantage of the features provided by the SPIAgent add-on. We will give an example of 
modifying an existing relation (the one created earlier in this guide) to take advantage of the 
SPIAgent features and will also cover configuring a new relation from scratch to use the 
SPIAgent.  
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Installing SPIAgent 

 
The SPIAgent only installer (SPIAgentSetup.exe) should be installed on every machine other 
than the machine with the full SureSync package. The full SureSync package includes an agent 
for that machine. 
 
Note: The components needed to use the SPIAgent are included with the full SureSync 
setup. However, to take advantage of functionality provided by the SPIAgent you must 
have SPIAgent licenses.  

Server Settings 

 
The next step is to configure your SPIAgent inside SureSync. Launch SureSync, click on "Tools", 
and then "SPIAgent Setup". You should get a panel like the one below.  
 

 
 
Select the SPIAgent from the drop down menu to begin configuring it. If the agent you want to 
configure does not appear in the list, you may enter a name for it by selecting "Add New 
Machine" from the drop down menu.  
 
Important: The machine name listed in the "Select a computer from this list to edit its settings" 
drop down menu must be the actual machine name for the machine you’re trying to connect to. 
Using an IP address or a random name in the drop down menu will result in the test failing.  
 
You will then want to:  

1. Check the box that says "Run SPIAgent on this computer".  
2. Enter the IP address or DNS name for the machine running this SPIAgent into the "Agent 

IP or DNS Name" field.  
3. Enter a username with adequate permissions to that machine in the “Default User ID” 

field. We recommend a domain administrator account. Be sure to configure the account 
as domain\user. If you wish to use a local account on that computer it can be formatted 
as machinename\user.  
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4. Enter the password for the account in the "Default Password" field.  
5. Make sure the user account specified here has "log on as batch job" rights on the 

machine in question.  
6. Click save and then test to verify the configuration.  

Modifying an Existing Relation 

 
For this example we will be modifying the "Evaluation Relation" relation we configured in the 
Relation section of this Guide.  
 
Each path in your relation must reference the SPIAgent on the machine where that path is 
located in order to use the SPIAgent functionality. In order to do this, click on the name of the 
relation in the left pane of the desktop interface. On the "General" tab you will see your root paths 
listed, which is displayed in the screenshot below:  
 

 
 
You will want to modify any path listed there which says [local agent] but references a path on a 
remote machine. To do this highlight the path and click on the "Edit" button. This will open a 
window like the one below. 
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To reference the remote agent you should select that remote machine from the "Relative 
Server/Agent" menu. In this example the remote machine is named "7DDN101-JeffK". The 
browse panel will now display the content of that machine as if you were sitting down at it. As you 
can see in this example we have selected the "7DDN101-JeffK" machine and browsed to the 
c:\data folder that is involved in this synchronization. When you are finished, click "OK".  
 
When you are done the results should look like the screenshot below. Notice there is one path on 
the local machine using [local agent] and the other path uses the agent that is installed on the 
machine where that path is located.  
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Note: You can synchronize between two remote machines by selecting their agents and adding 
the paths on those machines. The local machine does not need to be involved in all 
synchronizations you create as long as you’re licensed to synchronize to the two remote 
machines. 

Creating a New Relation with Agents 

 
The process for creating a new relation using agents is exactly the same as detailed above. You 
would go to the File menu, select "New" and then "Relation" and when you reach the panel below 
you will click the "Add" button to start adding your paths. 
 
This will bring up the "Add a New Root Path" dialog box. You would select the c:\data path from 
[local machine]. Then you would click add again, select the remote machine from the "Relative 
Server\Agent" list and add that path as well. The end result should look like the screenshot below. 
 

 

SPIAgent Configuration Utility 

 
The SPIAgent Configuration Utility can be used to change the port settings used by the SPIAgent. 
These settings are for advanced users only and in most instances do not need to be modified. 
You can access this panel by going to the Start menu and selecting 
Programs\SureSync\SPIAgent Configuration Utility. 

1.9 Creating a Real-Time Monitor 

A Real-Time Monitor is used in place of a schedule to constantly monitor changes in files. When 
a change is detected, the associated relation/rule is applied and the synchronization is 
immediately performed. 
  
The real-time feature requires the use of the optional SPIAgent component on each machine 
involved in the real-time synchronization. A SPIAgent license is also required for the local 
machine which will be running the job (if that machine is involved in the synchronization).  
 
To run real-time, your relation must reference SPIAgents. For more information on configuring 
your relations to use SPIAgent add-on please see the SPIAgent section of this guide. 



Software Pursuits, Inc. 
www.SoftwarePursuits.com  

19

 
In this example we will create a real-time monitor to process changes to our relation as they 
occur.  
 
Note: A Relation can only be active once. If you’re planning to run a Relation with a Real-Time 
Monitor then you should not attempt to run a Schedule of that same Relation at the same time. 
You will get errors about the Relation already being busy. If a Schedule exists to run a Relation 
you’re going to run with a Real-Time Monitor it should be placed on hold or deleted.  
 
To begin configuring your Real-Time Monitor go to the File menu, select New, and then Monitor.  
 
Important: The wizards are designed to quickly and easily configure the basic options needed to 
get a Real-Time Monitor up and running. SureSync is an extremely flexible product with many 
advanced options. Additional options can be specified on the properties panels for the Real-Time 
Monitor after it has been created. 

Name Your Monitor 

 

 
 
The first panel allows you to name your Real-Time Monitor. Enter the name of the Real-Time 
Monitor and an optional description. Then click “Next” to continue. 

Selecting What Relation(s) to Run 

 
The next panel is where you specify which relation you would like this Real-Time Monitor to run. 
Specify these relations by checking the box next to their name. You can run multiple Relations 
under one Real-Time Monitor. 
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Click the “Finish” button to create the Real-Time Monitor. 
 

Using the SPIAgent File Locking Add-on 

 
The SPIAgent File Locking Add-on add-on license enables file locking when running a Relation 
which contains a multi-directional rule run in a Real-Time Monitor. This option will allow one user 
to open a file and then lock the copies on all other machines involved in the synchronization. If 
another user attempts to open the same file they will get an error stating that the file is already in 
use. This prevents changes from happening to the same file on multiple sides of the 
synchronization. 
 
Details on setting up the SPIAgent File Locking Add-on can be found in the SureSync help file 
under SureSync Add-ons | SPIAgent File Locking Add-on. 

Modifying Your Real-Time Monitor 

 
When the wizard is complete you are returned to the SureSync desktop and the Real-Time 
Monitor you created is displayed.  
 
Now that the Real-Time Monitor is created it may be started by right-clicking on the Real-Time 
Monitor name and clicking "Start Monitor". You may also uncheck the box which says "Stop 
Monitor and place it on hold" on the General tab of the Real-Time Monitor and click apply to start 
the Real-Time Monitor. Next to the Real-Time Monitor name will be the message "Waiting to 
start" and then will change to "Active" automatically after a few moments.  
 
You can make changes to the options for your Real-Time Monitor in the main SureSync window 
by first clicking on the real-time monitor you wish to modify. You can then look through the tabs 
on the right side for options to change. Pressing F1 while on any tab will bring up context 
sensitive help describing the options in detail.  
 
Note: You must have a scheduler running for your real-time monitor to start. A scheduler can be 
installed by going to the Tools menu, selecting Schedulers, clicking on the Install button and then 
providing a username and password for the Scheduler to run under. 


